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Legal Notices 

 Information in this document is subject to change without notice and does not 
represent a commitment on the part of  Interwise, Inc.  

 The software and/or databases described in this document are furnished under a 
license agreement or nondisclosure agreement. The software and/or databases 
may be used or copied only in accordance with the agreement. The purchaser 
may make one copy of  the software for backup purposes.  

 No part of  this document may be reproduced or transmitted in any form or by 
any means, electronic or mechanical, including photocopying, recording, or 
information storage and retrieval systems, for any purpose other than the 
purchaser's personal use, without the express written permission of  Interwise, 
Inc. 

 Unless otherwise noted, all names of  companies, products, street addresses, and 
persons contained herein are part of  a completely fictitious scenario or scenarios 
and are designed solely to document the use of  an Interwise product. 

 Interwise Connect – Working with Outlook Guide, document number V7.2, 
issued on June 30, 2006. 

 Windows is a trademark of  Microsoft Corporation. All other trademarks belong 
to their respective owners. 

 © Interwise, Inc. 1994-2006. All rights reserved. 
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Introduction 
The Interwise Outlook AddIn enables you to schedule, manage and 
join Interwise Events through Microsoft Outlook. 

After installing the Outlook AddIn, you can: 
 Schedule and enter an Interwise Event. 
 Easily convert already scheduled Outlook meetings into Interwise 

Events. 
 View your scheduled Interwise Events in the Outlook Calendar, as 

per regular Outlook meetings.  
 Modify Outlook AddIn settings per Event to suit your own 

personal requirements (such as allowing Event attendees to use 
their telephone or a headset/microphone and speakers for their 
audio during an Event). 

 
Note: The Interwise Outlook AddIn is compatible with Office XP, 2000 
and 2003. Note that the latest Service Pack for each of the mentioned 
Office versions must be installed. 
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Installing the Outlook AddIn 
The first step in getting your Microsoft Outlook Calendar to work with 
Interwise Events is to install the Outlook AddIn. The following 
procedure describes how to install the Outlook AddIn  

 To install the Outlook AddIn: 

1 Locate the Outlook-AddIn.MSI file and double-click on it to 
launch the installation wizard. The Welcome window is displayed. 

 
Tip: If you have Outlook open on your computer, you must first 
close Outlook before proceeding with the installation. 

 
Figure 1: Welcome Window  

2 Click Next. The License Agreement window is displayed. 
3 Click Yes. The Destination Folder window is displayed. 
4 Click Next (or select a destination folder by clicking Browse, and 

then click Next). The Ready to Install window is displayed. 
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5 Click Next. The setup files are copied to your computer. Upon 
completion, the Successfully Installed window is displayed. 

 
Figure 2: Successfully Installed Window  

6 Click Finish. The Outlook AddIn is installed on your computer.  
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Scheduling iMeeting Events  
The Interwise Outlook AddIn enables you to work through Microsoft 
Outlook to schedule, manage and join Interwise Events. The same 
Events scheduled/updated in Outlook are simultaneously 
scheduled/updated in the Interwise Communications Center (ICC), an 
Interwise web application. 
This section includes the following: 

 Scheduling an iMeeting, see below  
 Scheduling a Recurring iMeeting, page 9 
 Converting a scheduled Outlook meeting into an Interwise 

iMeeting, page 9 
 Customizing Event settings for an Event, page 11 
 Customizing Event Settings for Recurring Events, page 17 
 Working with the Delegate Access / Shared Calendar 

Features, page 19 

Scheduling an iMeeting 
This section describes how to schedule a new iMeeting Event. 

 
Note: For information about scheduling a recurring iMeeting, see 
page 9. 

  To schedule an iMeeting Event: 

1 From the Outlook toolbar, click .  
Note that Interwise provides many other ways to schedule an 
Interwise iMeeting, such as by selecting New from the File menu 
and then clicking Interwise Event, OR by selecting a block of time 
in your Calendar and then right-clicking and selecting New 
Interwise Event. 
The following window is displayed: 
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Figure 3: iMeeting Event in Outlook  

2 If you want to change the location displayed in the ICC URL box, 
select a URL from the dropdown list (the dropdown list displays a 
list of ICC URLs that were defined in the Preferences window, as 
described on page 20) or type in the required URL. For example, 
enter ‘http://demo.interwise.com/events’. This option may be 
disabled by your organization. 

 
Note: You can also change the default ICC URL, as described on 
page 22. The default ICC URL is the URL automatically displayed 
when you first open an Outlook form to schedule an Event (as 
shown in Figure 3). 

3 In the Appointment tab, define the following: 
 Select the relevant iMeeting invitees (as you would normally 

select mail recipients). 
 In the Subject line, enter the Event name. 
 Define the Start and End times and any other settings specific 

to your Event. 
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4 In the Scheduling (or Attendee Availability if you are working 
with Windows 2000) tab, you can determine the availability of any 
of the invitees, as you would normally do when creating a meeting 
through Outlook. 

5 You can modify additional Event settings via the Customize 
Event Settings button. The settings initially displayed are based on 
the default settings of the ICC you selected in step 2. See page 11 
for further information. 

6 Click Send. You may be prompted to enter your ICC user name 
and password, according to how the Outlook AddIn has been 
configured by your system administrator. 

The selected invitees are notified accordingly of the iMeeting Event 
with invitation information generated by the Interwise system, 
which is included in the body of the invitation. This invitation 
information includes all the relevant details with which the invitees 
can access the Event. 

Scheduling a Recurring iMeeting 
Using Outlook’s recurrence feature, you can schedule a recurring 
iMeeting. 

 To schedule a recurring iMeeting Event: 

1 In the Calendar view, right-click on the Calendar and in the 
displayed popup menu, select New Interwise Recurring Event, 
OR, 
In the Calendar view, from the Outlook menu bar, click 
Actions>New Interwise Recurring Event. 
The Outlook form is displayed with the Appointment Recurrence 
window superimposed on it, as shown below. 
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Figure 4: Recurring iMeeting Event in Outlook  

2 Define your recurring settings, including the time, pattern and range 
and then click OK.  

3 Define your Event settings, as described in the Scheduling an iMeeting 
section.   

4 Click Send. You may be prompted to enter your ICC user name 
and password, according to how the Outlook AddIn has been 
configured by your system administrator. 

 
Note: You will only be able to view the upcoming week's recurring 
Events in the ICC. For example, if you created an Event to recur 
weekly, with the first instance scheduled for the current week, when 
you access the ICC only this first Event will be displayed.  
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Converting a scheduled Outlook meeting into an 
Interwise iMeeting 

This section describes how to easily convert an already scheduled 
Outlook meeting into an Interwise iMeeting. 

 To convert a scheduled Outlook meeting to an Interwise 
Event: 

1 Display the Outlook Calendar.  
2 Locate and double-click the Event you want to convert. 

3 In the displayed Outlook form, click . 
4 Define any Event settings, as required (see the Creating an iMeeting 

section for further information). 
5 Click Send Update. The selected invitees will receive an updated 

email invitation with all the relevant information required to access 
the Event. 

Customizing Event Settings for an Event 
When scheduling and/or updating Interwise Events you can customize 
a number of default settings, including the following: 

 Event Audio, see below 
 Event Options, page 14 

If you want to customize the settings for Recurring Events (whether a 
single occurrence or the entire series), refer to the Customizing Event 
Settings for Recurring Events section, on page 17. 

 
Note: The Event settings initially displayed when scheduling the Event 
and clicking the Customize Event Settings button are the default 
settings of the specified ICC, as defined by that ICC’s System Manager.  

When updating the Event, the settings displayed when clicking 
Customize Event Settings are those previously defined when you 
scheduled the Event. 
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Customizing Event Audio Settings 

You can define the Event audio to use either Interwise Audio 
Conferencing or another conferencing call service. When selecting to 
use Interwise Audio Conferencing you can also select the audio devices 
that Event attendees can use during the Event (if configured 
accordingly by the ICC System Manager). 

 To define the Event to use Interwise Audio Conferencing: 

1 In the displayed Outlook form (when scheduling and/or updating 
an Interwise Event), click Customize Event Settings. The 
following window is displayed:  

 
Figure 5: Customize Event Settings – Audio Tab  

 
Note: The window displayed above is for example purposes only. 
The actual window displayed will depend on the ICC default settings.  

2 In the Audio Settings section of the displayed Audio tab, select 
Interwise Audio Conferencing. 
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3 In the Interwise Audio Conferencing section, select the relevant audio 
option. Using Figure 5 as an example, you can select No one may 
use a telephone if you want all users to connect to the Event with 
their computers (with either a headset OR microphone and 
speakers). Alternatively, select Anyone may use a telephone if you 
want attendees to choose their own preferred device (either a 
telephone OR headset/microphone and speakers). 
Note that if the ICC System Manager has defined the ICC to 
support only telephones or only headsets/microphones and 
speakers, the options available will reflect this. 

4 Click OK. 

 To define the Event to use another conferencing call service: 

1 In the Audio Settings section of the displayed Audio tab, as shown 
on page 12, select Use Other Conference Call Service. The 
section immediately below it is automatically replaced with the Other 
Conference Call Service section, as shown below. 

 
Figure 6: Customize Event Settings – Other Conference Call Service  
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2 Define the following fields: 
 Call-in Numbers: Define a Local number that local 

Participants should call in order to join the conference call and 
an International number that internationally located 
Participants should call. 

 Participant’s Access Code: The code required by each 
Participant to actually enter the conference call. 

 Moderator’s Access Code: The code required by the 
Moderator to actually enter the conference call. 

 Comments: Enter any relevant comments. For example, you 
may want to include a quick overview of conference call 
procedures. A maximum of 1400 characters is permitted. 

 
Tip: If you need to create a new line, press <Enter>. 

3 Click OK. 

Customizing Event Options 

In the Options tab of the Customize Event Settings window you can 
define the following settings: 

 Recording and Video settings, such as if the Event should be 
recorded on the server and whether video conferencing is enabled, 
see below. 

 Event Entry and Security settings, such as the Participant 
application type Event attendees should use, see page 16. 

 To customize Recording and Video settings: 

1 In the Customize Event Settings window, click the Options tab. The 
following window is displayed: 
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Figure 7: Customize Event Settings – Options Tab 

2 In the Recording and Video section, define the following: 
 Record on the Server: Automatically makes a recording of the 

meeting available for future use.  
 Publish Recording to Participants: Enables Participants to 

view the recording at a later date via the ICC (this option is only 
enabled if the Record on the Server option is selected). 

 Allow Participants to Record Locally: Enables Event 
attendees to record the Event on their computer. 

 Allow Participants to use Video: Enables video conferencing 
to be used during the Event. 

3 Define other options, as described in the following section, or click 
OK. 
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 To customize Event Entry and Security settings: 

1 In the displayed Customize Event Settings window, as shown on 
page 15, click the Options tab. 

2 In the Event Entry and Security section, define the following: 
 Protect Communication with Encryption: This option is 

only displayed if the ICC System Manager has configured Event 
security settings to be set per Event - if it is not displayed the 
default ICC setting is implemented. Select either No (applies a 
standard level of security, which is also compatible with 
previous versions of Interwise applications) or Yes (applies a 
high level of security via SSL (Secure Sockets Layer).  

 Participant Application Type: This option is only displayed if 
the ICC System Manager has configured Event Entry settings 
to be set per Event – if it is not displayed the default ICC 
setting is implemented. Select the default application type for 
the Event from one of the following: 
 Participant Application: Participants can only enter the 

Event with the Participant application. If a compatible 
version of the Participant application is not already installed, 
the latest version is automatically installed on the 
Participant’s computer. 

 Java Participant: Participants can only enter the Event 
with the Java Participant. Note that if the users’ browser 
settings are not Java enabled, users will not be able to access 
the Event using the Java Participant. 

 Ask Participant: Participants will be prompted to select 
either the Participant application or the Java Participant, 
regardless of the Event settings defined by the ICC System 
Manager. 

3 Define other Event Options, as described in the previous section, 
or click OK. 
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Customizing Event Settings for Recurring Events 
As described in the previous section, you can also customize Audio, 
Materials and Options settings for Recurring Events.  

When initially scheduling the Recurring Event series, the settings you 
define are applied to all occurrences. However, when updating a 
Recurring Event's single occurrence or the entire series, a number of 
additional factors should be taken into consideration, as described 
below. 

This section includes the following: 
 Customizing Event settings for a single occurrence, see below 
 Customizing Event settings for a series, see below  

 To customize or update Event settings for a single occurrence: 

1 In the Outlook Calendar, select the occurrence you want to 
customize. When prompted to select either this occurrence or the 
series, select Open this occurrence. 

2 In the displayed Outlook form, click Customize Event Settings, 
and then modify the settings as required (refer to the previous 
section for further information). Note that the settings you define 
are specific to this occurrence and will not be applied to the series. 

 To customize or update Event settings for a series: 

1 In the Outlook Calendar, select an occurrence of the series you 
want to customize. When prompted to select either this occurrence 
or the series, select Open the series. 

2 In the displayed Outlook form, click Customize Event Settings, 
and then modify the settings as required (refer to the previous 
section for further information). Upon clicking OK, the following 
message is displayed: 
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Figure 8: Customize Event Settings – Updating Series 

3 Select Change only the specific settings for the series if you 
want to apply the specific changes you have made to the series. For 
example, if you defined the series to allow Participants to use video 
in each occurrence, only this setting is applied to all occurrences. 
Any single occurrences with other settings (such as Materials or 
Audio options) that are different to the series will remain with these 
different settings. 
OR, 
Select Change ALL the Interwise settings for the series if you 
want to make the settings you have customized (and those settings 
you may not have modified) as the settings for the entire series. 
Note that any occurrences with different settings will be overwritten 
with these new settings for the series. For example, if an occurrence 
has Materials that were uploaded to the ICC specifically for that 
occurrence, these Materials will be removed from the occurrence if 
the series you defined in Step 2 has no Materials specified. 

4 Click OK.  
5 Click Send Update to update others of the changes you have 

made. 
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Working with the Delegate Access / Shared 
Calendar Features  

If you have been granted with permissions to manage someone else’s 
calendar (using Outlook’s Delegate Access or Share Calendar feature), 
you can also create Interwise iMeeting Events just as you would create 
regular Outlook meetings on behalf of this person. 

However, there are several Interwise Outlook AddIn specific settings/ 
prerequisites that need to be taken into consideration: 

 Both you and the person on whose calendar you are working must 
have the Interwise Outlook AddIn installed.  

 Both you and the person on whose calendar you are working must 
have valid user accounts on the relevant ICC. Both accounts on the 
ICC must be set with the primary email address (SMTP).  

 When you create a meeting on the other person’s calendar, the 
actual owner of the meeting in the ICC is the other person, similarly 
to Outlook.   
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Modifying Outlook AddIn Options 
This section describes how to modify Outlook AddIn Options.  

Interwise Events you schedule in Outlook are also scheduled in the 
selected ICC (which is selected when scheduling the Event, as described 
on page 7). Via the Outlook AddIn Options, you can define the list of 
ICCs that are available (in the ICC URL dropdown list) when you 
schedule an Interwise Event. You can add or delete ICCs from this list, 
as well as make one of the ICCs the default ICC automatically displayed 
in the Outlook form when scheduling/updating an Interwise Event.  

 Adding or Deleting ICCs, see below 
 Changing the Default ICC, page 22  

Adding or Deleting ICCs 
This section describes how to add/remove an ICC to/from the list of 
available ICCs. These ICCs are included in the ICC URL dropdown list 
when scheduling an Event (see page 7).  

Note that only one of these ICCs can be defined as the default ICC (as 
described on page 22), though you can change the default ICC at any 
time.  

 To add an ICC: 

1 From the Outlook toolbar, click Interwise Options>Preferences. 
The Preferences window is displayed. 
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Figure 9: Preferences Window  

2 Enter an ICC URL in the text box and then click Add. The new 
ICC is automatically added to the list of Existing ICCs. 

3 Click OK.  
You can also make the new ICC the default ICC for all future 
Interwise Outlook Events, as described on page 22. It will 
automatically be displayed as the selected ICC when scheduling 
Events, though can be replaced by another ICC in the ICC URL 
dropdown list, if required. 

 To delete an ICC: 

1 From the list of Existing ICCs in the Preferences window, as shown 
above, select the relevant ICC.  

2 Click Delete. In the displayed confirmation message, click Yes. 
3 Click OK. 
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Changing the Default ICC 
You can change the default ICC at any time. The default ICC is the 
ICC that is automatically displayed in the Outlook form (in the ICC 
URL field) when scheduling/updating an Interwise Event. 

 To change the default ICC: 

In the displayed Preferences window, as shown on page 21, select the 
relevant ICC and then click Set as default. The selected ICC is then 
highlighted in bold and (Default) is displayed alongside it. 

 
Tip: Click Restore Defaults to revert to the original default ICC. 
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Receiving Invitations to Events 
Once you have installed the Interwise Outlook AddIn, Interwise Event 
invitations sent by others will be included in your Inbox. According to 
how your organization has its Outlook Exchange Server configured, 
you will receive messages with either of the following icons alongside 
each invitation in your Inbox: 

 
Meeting Request  

The regular Outlook meeting icon. In order for the Interwise 
Event to be added to your Outlook Calendar, you must right-
click the message in your Inbox and from the displayed popup 
menu, select Accept.  

 Email Invitation 

This icon indicates the Interwise Event has automatically been 
added to your Outlook Calendar. These types of invitations are 
generally sent by users on a different Exchange Server, OR were 
scheduled in the ICC.  

When the Event goes Live, you can directly access the Event from a 
link in the email invitation or the Calendar, as described in the Joining 
Events section.  
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Viewing Interwise Events in your 
Outlook Calendar 

In order to view the Events in your Calendar, simply access the 
Calendar as you normally would and locate the relevant Event. Events 
are posted into your Calendar as any normal Outlook meeting is posted, 
as shown below: 

 
Figure 10: Events in Outlook Calendar  
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Joining Events 
When an Event is scheduled to start, you can double-click the relevant 
Calendar entry and then click the Join Event Now button. You can 
also access the mail notification you received from the Interwise system 
and click the relevant link to access the Event. The Participant 
application is automatically opened upon entering the Event. 

 To join an Interwise Event: 

1 Display the Outlook Calendar.  
2 Locate and double-click the Event you want to join. 
3 In the displayed Outlook window, click Join Event Now from the 

Interwise toolbar. Your browser is then opened automatically and 
you enter the Event. According to how the Event has been 
configured, you may be prompted to select an audio device 
(microphone and speakers/a headset OR your telephone) with 
which to listen and speak during the Event. 
OR, 
If you want to join the Event using your telephone only, click 
Dial-in Instructions (this button is only displayed if the Event is 
configured to allow the use of telephones). This displays the Dial-in 
Instructions page, which guides you through the dial-in process. 

 
Note: When clicking Join Event Now, you may be prompted to 
enter your first name, last name and email address if the Interwise 
system does not recognize your email address, OR your user name 
and password if the Interwise system is configured accordingly. 

Alternatively, you can click the link in the email invitation to access 
the Event. However, this link is not a personal link, and you WILL 
be prompted to enter your first name, last name and email address.  

 



Working with Outlook  
 INTERWISE CONNECT V7.2 

26 

Updating iMeeting Events 
As with any regular Outlook meeting, you can update and delete an 
iMeeting as required.   

 
Note: Events created in Outlook can only be modified in Outlook – 
they cannot be modified via the ICC. 

 To update an iMeeting Event: 

1 Access the relevant Event in your Outlook Calendar and 
double-click on it to open the Meeting window, as shown on 
page 8. 

2 Modify the details as required and re-send the iMeeting notification 
to the relevant invitees, 
OR, 

Click  to delete the iMeeting. You can also send notification to 
the invitees that the iMeeting has been canceled.  
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